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INTRODUCTION

OctaneRender™ for Carrara® User Manual
Version 2.0 beta (August 2014)
http:/frender otoy com
OctaneRender™ for use with DAZ 3D® Carrara® 3D Authoring Software ® OTOY INC. 2014.
developed by Simon Guard
All rights reserved.
OctaneRender™ and OTOY® and their logos are trademarks of OTOY INC_

DAZ 3D and Carrara are registered trademarks of DAZ Productions Inc. and/or its subsidiaries and/or affiliates in the U.S. and/or other countries.

Welcome to OctaneRender™ for Carrara®.

The following video is by Orion_uk

Features

Integrated Environment

- Texture (HDRI)
- Daylight
- Texture + Daylight

Integrated Camera

- Thin Lens and Isomorphic
- Stereo Rendering

Integrated Materials

- Octane Materials can be configured while preserving original Carrara Shaders
- Works with internal or external texture maps.
- All current Octane 2.0 Materials and Textures are supported.

Conversion of existing Carrara Shaders

- Reasanable conversion of Multi Channel shaders which take into account
- Color

- Alpha

- Highlight

- Shininess

- Bump

- Reflection

- Transparency

- Refraction

- Glow

The following Shaders are directly converted to Octane Shaders
- Color

- Color Gradient

- Index of Refraction (in Refraction Channel)

- Texture Map

- Value (0-100 and (0-10000)

- Mixer

- Multiply

- Checkers

"R octanererider

The following shaders are mapped but don't produce the same result
- Add (mapped to Multiply)

- Marble

- Fractal Noise (mapped to Rigid Fractal)

- Turbulence

External Render Window

- Displays the Octane Render View Port (ORVP)
- Shows stats for the current render

- Updates when changes are made in Carrara.

- Provides:

- .ocs and .orbx exporting

- Image saving

- Diagnostics

- Pause and Resume render

- Lock render from updates from Carrara

- White Point picker

- Material picker

- Focus picker

- Restart render

- Free Camera mode.

- Can zoom and pan image.

- In free camera mode you can control the camera view in the same way as the standalone (pan, zoom, rotate).

asensmeosas .

External Settings Window

- Set the render target settings including

- Imager

- Kernal (DL, Path Tracing, PMC, Info Channel)

- Post Processing

- Render Target setting are saved and loaded seperately from the .car file (at this time)
- Animation

- animations rendered to image sequences

- camera motion blur

- Devices

- control which GPUs to use and their priority

- Octane Live DB

- download materials from the Live DB database and save them as Carrara browser files (.cbr)
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HARDWARE REQUIREMENTS

OctaneRender for Carrara requires a NVIDIA CUDA-enabled video card with Compute Capability 2.0 or above.

The official list of NVIDIA CUDA-enabled products is located at ¥ per.nvidia. |

gp

OctaneRender runs on Fermi (e.g. GTX 480, GTX 580, GTX 590) and Kepler (e.g. GTX 680, GTX 690) GPUs, the high-end GTX780 and GTX Titan. It also supports older CUDA enabled consumer video cards (Nvidia
GeForce GT 400 series and up) but it will be subject to memory size and speed limitations on those cards. Kepler GPUs allow a higher texture limit (256 compared to 128 on Fermi) and are also more power efficient
and more silent than Fermi cards. GPUs from the GeForce line are usually higher clocked and render faster than the more expensive Quadro and Tesla GPUs.

GeForce cards are fast and cost effective, but have less VRAM than Quadro and Tesla cards. OctaneRender scales perfectly in a multi GPU configuration and can use different types of Nvidia cards at once e g. a
GeForce GTX 460 combined with a Quadro 6000.
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SOFTWARE REQUIREMENTS

The plugin requires OctaneRender Standalone Edition to be installed and activated. The Standalone Edition does not need to be the same Octane version as the plugin — since they operate separately.

CARRIRA 8

The plugin supports Carrara 8/8.5 Pro or Standard, 64 or 32 bit for Windows.
OctaneRender for Carrara is available for the following operating systems:

= Windows 7, Windows 8, Windows 8.1 - 64 or 32 bit
The OctaneRender for Carrara plugin uses the Microsoft .Net 4.5 or greater framework.
Note that it is highly recommended that you use a 64 bit addition of Carrara because it can take a lot of memory to load scenes into Octane.

OctaneRender requires a Nvidia driver supporting CUDA 5.5 (http://www.nvidia i aspx?).

@otoy
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PLUGIN ACTIVATION
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The OctaneRender™ for Carrara plugin requires internet access to launch the first time. Internet access is not required to use both OctaneRender™ and OctaneRender™ for Carrara plugin. When no internet access

is present, the Live Database will not be accessible.

Upon launching the plugin for the first time, the user will need to log in to their OctaneLive™ account which is associated with their forum log-in information. This information can be found in the customer section of the

OctaneRender™ website.

All subsequent renderings will not need log in information entered.

Your OctaneRender license can only be active on one machine at a time. If you wish to transfer your license to another machine, you will have to deactivate it on the current machine and reactivate it on the other one,

(re-activation might cause a slight delay). In case of difficulty, contact us here.

To activate the OctaneRender for Carrara plugin, please do the following.

m Start Carrara and load a scene (new or existing.)

= Select the [Edit -> Octane Commands -> Open Octane Render Window] menu item

Windows: Ve HElp

cul+D
Duplicate With Symmetry... Cirl+Shift+D
Flip..

Select Al
‘Select Al Primitives

Animate ||

7

Brow

= On the viewport menu select Render Target Settings. (The third icon.)

0000 & X

» Select the Octane Live tab.

= Enter your Octane Live ID and password and then select Activate

= You should then shutdown and restart Carrara.

Interface  Phy
b Ambient

¢ Environment

cts Shaders

Lo

Sounds
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INSTALLATION PROCESS

®oloy

Ensure Carrara is not currently running on your PC, and then run the provided installation file (octane_carrara_x64_[version number].exe). Select the install directory of your Carrara installation. The installer will copy all

the plugin files into the appropriate place.
Once installed, when you next run Carrara, the plugin will be available from the Edit menu.

You will need to activate the plugin prior to using it for the first time.

Once activated, you can start using the plugin to render.

Start Carrara and load a scene (new or existing.)
Select the [Edit -= Octane Commands -= Open Octane Render Window] menu item.
On the viewport menu select Render Target Settings. (The third icon.)

Select the Octane Live tab.

Enter your Octane Live ID and password and then select Activate.
You should then shutdown and restart Carrara.
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GPU SETTINGS

The CUDA Devices tab is located on the Devices tab of the Render Target Settings dialog

= Select the [Edit -» Octane Commands -= Open Octane Render Window] menu item.
= On the viewport menu select Render Target Settings. (The third icon.)

You can enable or disable your CUDA Devices from this window.

The render prierity option can throttle down rendering on one or more GPU's to improve system responsiveness especially when rendering on a GPU used for the display.
If you are using a single card for both CUDA rendering and as your Windows display adapter, it is recommended that you tick the priority checkbox.

®otoy

CUDA Devices configuration is stored locally on your machine and is session persistent. When transferring assets along with .skp scene file to another machine all CUDA Devices configs are not being transferred

and have to be reconfigured.

For troubleshooting problems, please refer to the Troubleshooting section in the Oct Render™ Standal Editi

User M
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USING THE INTEGRATED CARRARA PLUGIN

OctaneRender Viewport (ORVP)
Render Settings
Camera
Thin Lens
Panoramic
Environment
Daylight
Texture
Sun + Texture
Materials
Using Carrara Materials
Octane Materials
Converting Carrara Shaders
Octane Live DB
Geometry
Instancing
Trees
Optimizing Mesh
Object Layer

Animation
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OCTANERENDER VIEWPORT (ORVP)

The OctaneRender Viewport is where the rendering of the scene takes place. It is accessed from the Edit menu in Carrara.
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Open Octane Render Window D

OctaneRender™
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Panning and Zooming

You can pan the image by pressing the <CTRL= key while dragging the image.

You can zoom the image by pressing the <CTRL> key and scrolling the mouse wheel or by pressing the <CTRL> and <ALT> key while dragging the image up or down.

Menu Bar
From the menu bar you can perform the following:
& Load RenderTarget — Loads the render target from a .ocs file.

E Save RenderTarget — Saves the render target to an .ocs file.

® oloy

Note that the render target setting for the Imager, Kernel, and Post Production are not currently saved as part of a Carrara Scene file (.car). You need to load and save the render target seftings separately. This will be

addressed in the near future.

5 Settings — Opens the Octane settings dialog.

@ save Image — Saves the current image to disk.

[= Export Scene - exports the current scene to disk as either an .ocs or an _orbx file.

L) Open Diagnostics Window — opens the Octane diagnostics window.

@ Restart - Restarts the current render.

(® Resume - Resumes the render if it was paused.

L

@ Pause - Pauses the current render.
® Stop — Stops the render and clears the scene from the Octane buffers (including the current image).
& Lock Scene (toggle) - Lock the current scene from changes made in Carrara. Allows you to make changes in Carrara without affecting the current render.

B white Point Picker (toggle). Allows you to set the white point of the scene by clicking on the render.

Material Picker (toggle). Allows you to switch to the shader room for the selected texture.

#) Set Focus Point (toggle). Allows you to set the focus point for the Camera

.
o

i Auto Focus (toggle). Allow you to enable or disable the Camera auto focus.

Reload scene. Reloads the current scene into Octane. May be useful if the ViewPort fails to pick up a change you made in Carrara

: Reset Image Pan/Zoom. Resets the image in the viewport to its original position and zoom level.
™ Free camera mode (toggle). Enters free camera mode where you change navigate the scene in the viewport in the same way as the Octane Standalone.

m Use left click and drag to rotate.
= Use right click and drag to pan.

= Use the mouse wheel or the <ALT= key + left click and drag to zoom.
B camera Target Picker (toggle). Only available in free camera mode. Allows you to pick the target rotation point of the camera.

Note that the free camera mode has no effect on the camera in Carrara. Leaving free camera mode will restore the viewport to the render camera.

© Otoy; inc. 2013 AN Rights Reserved.
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RENDER SETTINGS

The Octane Settings dialog is where you can make changes to the Render Target Imager, Kernel, and Post Processing settings. Additional tabs allow you to generate an animation, setup your GPU devices, register
your plugin, download LiveDB materials, and configure preferences.

‘Camera Imager ~

Ambient Occlusion «

O —

2 Bo

Please refer to the Octane Standalone documentation for the meaning of all the Render Target settings.

Note that the render target seftings for the Imager, Kernel, and Post Production are not currently saved as part of a Carrara Scene file (.car). You need to load and save the render target settings separately. This will be
addressed in the near future.

ClsmSmonvideosButest |||

The Devices tab is used to configure you GPUs. Please refer to the GPU Settings section for further details.

The Octane Live tab is used to activate the plugin. Please refer to the Plugin Activation section for further details.

Octane Live DB
‘\Users\Simon\Documents\DAZ 3D\Caara & 5\My PresetsiMy ShadersiLive DB ..

Download New (13) Download All (692)

The Octane Live DB tab is used to download Octane material shaders from the Octane Live DB database. Please refer to the Live DE section for more details.

Preferences is where you can tweak the behavior and look of the plugin.

Auto Start Render: Determines whether the render starts as soon as you open the viewport. If this box is unchecked then you need to press the Resume (Play) button on the Viewport menu bar to start the render.
Render View Font Size: determines the font size of the viewport status bar.

Settings Font Size: determines the font size of the settings dialog

@ Otoy, inc. 2013 All Rights Reserved.
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IMAGE SIZE

The size of the image rendered by the plugin is configured in the Carrara Render Room on the Output tab.

Only the Width and Height fields have any effect on the rendered image.

®otoy
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CAMERA

The OctaneRender for Carrara plugin uses the position and orientation of the current Render Camera in Carrara.

Rendering

Thin Lens

Panoramic

®otoy
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THIN LENS

H2EdV RENMOO0O

IR IORR N 4 Wct

The plugin will use the Carrara settings for the lens size to determine a Field of View that matches the Carrara Production Frame.
The plugin will also use the Carrara Distance to Near Plane setting to set the Octane Near clip depth.

Camera 1 : Camera

Motion | Mo
eral

The plugin will use the Carrara setting for Zoom to determine a field of view that matches the Carrara Production Frame.
The plugin will also use the Carrara Distance to Near Plane setting to set the Octane near clip depth.

AF| 5 & | =

Gotoy

There are two ways that you can control Depth of Field in the plugin. You can either use the Carrara Depth of Field effect, or you can use the Focal Depth and Aperture settings in the Octane Thin Lens effect

Camera 1 : Camara

To control the depth of field using the Carrara Depth of Field effect you need to Enable the effect and then open the DoF editor by pressing the Edit button. Note that the Aperture, Auto Focus, and Focal Depth settings

in the Octane Thin Lens effect are ignored while the Carrara Depth of Field effect is enabled.

When using the Carrara Depth of Field effect the Focus setting controls the field depth and the Blur Intensity controls the aperture. All other settings are ignored by the plugin.

NOTE: In Carrara, depth of field is optional, in Octane it is always enabled. To achieve a near infinite DoF you should set the Aperture setting in the Octane Thin Lens effect to zero.

Additional settings can be set for the Octane camera using the Octane Thin Lens effect.

Camera 1 : Camera

al Mot Mo

Thin Lans

Please refer to the Octane Standalone manual for further details on these settings.

The Octane Thin Lens Camera with the anaglyphic stereo effect enabled.

2P GENMQOO0O| &
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PANORAMIC

2B d RENMOO0O

Spherical : Camera

Motion | Modiifiers
|

Spheri

The plugin will use the Carrara settings for the Zoom to determine a Horizontal Field of View that matches the Carrara Production Frame.
The plugin will also use the Carrara Distance to Near Plane setting to set the Octane Near clip depth.

Additional camera settings can be set in the Octane Panoramic effect.

mara

Modifiers

tanel T
AF| D s [m
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ENVIRONMENT

Daylight
Texture

Sun + Texture

@otoy
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DAYLIGHT

Daylight in the Octane plugin is achieved by setting Carrara's Atmosphere to Realistic Sky.

The position of the sun is set using the Realistic Sky properties. You can either use the sun position ball or set time/space coordinates using the advanced button.

The position of the sun can alse be controlled using Carrara’s Sun Light widget.

Additional daylight options can be set using the Octane Environment scene effect.

See the Octane Standalone Manual for details on the daylight settings.

Gotoy
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TEXTURE

Carrara supports a number of background options. The options supported by the plugin include Color, HDRI, and Map.

[

B options are

You can rotate the background image by setting the Z Rotation override checkbox and adjusting the Z Rotation slider.
You can adjust the Gamma of the background image by setting the Gamma override checkbox and adjusting the Gamma slider.

You can also completely override the background texture and create your own texture from the available Octane texture nodes.

in the Octane Environment scene effect.

®otoy
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SUN + TEXTURE

To use the OctaneRender 2.0 Sun + Texture background feature simply define both a Realistic Sky Atmosphere and a background.

Interface P

®otoy
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MATERIALS

Using Carrara Materials
Octane Materials
Converting Carrara Shaders

Octane Live DB
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USING CARRARA MATERIALS
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The OctaneRender for Carrara plugin will do its best to convert existing Carrara Shaders to Octane Materials. It does this be examining the various shader channels and calculates a best fit Octane Material for the
shader. For a multi-channel shader the plugin considers the Color, Alpha, Highlight, Shininess, Bump, Reflection, Transparency, Refraction, and Glow channels. The Subsurface Scattering, Translucency, and

Displacement channels are not considered by the plugin at this time.

WARNING: Configuring the displacement channel in Carrara (not to be confused with the Octane displacement pin) can result in very high reselution meshes being processed by the Octane plugin. This is due to the

fact that Carrara applies the displacement to the mesh before delivering the mesh to Octane for processing. Caution should be used when using Carrara's native displacement channel.

Shaders that are supported by the plugin include:

= Color

= Color Gradient

= Index of Refraction (in Refraction Channel)
= Texture Map

= Value (0-100 and (0-10000)

u Mixer

= Multiply

» Checkers

The following shaders are mapped but don't produce the same result

= Add (mapped to Multiply})

= Marble

= Fractal Noise (mapped to Rigid Fractal)
= Turbulence
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OCTANE MATERIALS

Octane Materials can be defined directly within Carrara by adding an Octane Material top level shader.
The Octane Material shader consists of two pins:

The Shader pin can contain a Carrara shader that will be used by Carrara in its native renderer.
The Material pin contains the Octane Material that you want to define and starts with any of the standard Octane Material nodes (Glossy, Diffuse, Specular, Portal, or Mix)

With one exception, you can use the same nodes that you would use in the Octane Standalone renderer. Please refer to the Octane Standalone Manual for details on creating Octane Materials.

For Image nodes (RGB, Greyscale, and Alpha) there is an extra pin where you can connect a Carrara Texture Map node.

®otoy

The plugin will honor all of the Texture Map settings when the Use Texture Map Settings checkbox is set. Otherwise, only the image will be used and any other settings will need to be done using the Octane nodes.

NOTE: Only 8 bit images are supported when using the Texture Map. If you want to use a 16 bit image (IES or HDRI for example) then you should set the image using the Load button and set the Texture Map channel

to None.
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CONVERTING CARRARA SHADERS

The OctaneRender for Carrara plugin does a reasonable job of converting Carrara shaders into Octane Materials. However, sometimes you need to create your own Octane Material shader. For those cases you can
start by converting a Carrara Shader into an Octane Material shader and modify it to suit your needs.

To convert an existing Carrara Shader:

= Switch to the Assembly Room and select the object containing the Shader that you want to convert.
= From the Edit menu select Octane Commands -> Set Octane Materials.

This will convert all the materials attached to the object to Octane Material shaders. You can then switch to the material room and edit the Octane Material as you see fit.

NOTE: This command only targets Multi-Channel shaders. If you have a Layers List that contains Multi-Channel shaders then all the Multi-Channel shaders within the Layers List will be converted. Other types of
complex shaders that contain Multi-Channel shaders may or may not be converted.
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OCTANE LIVE DB
As part of your Octane license you have access to hundreds of community created materials. You can download these materials for use within the OctaneRender for Carrara plugin.
From the Settings window select the Octane Live DB tab.

A
Qctane Live DB

C:Users\SimoniDocuments\DAZ 3D\Carrara 8.5\My PresetsiMy ShadersiLive DB ]

Dowinload All (694)

From here you have the option of downloading the entire database or just the newly added ones. If this is your first time downloading then you will need to download them all.
NOTE: A future update will allow you to download individual materials.

Once you have downloaded the materials they will be available to use from the Browser and Shader Preset windows.

If you did not download to the default location then you will need to add the LiveDB directory to Carrara manually.

To do this, select the browser and then select the Shaders tab.

On the far right of the browser window select the File/Folder Menu button and then select Add Folder.

Navigate to the Live DB directory specified above and then select OK.

You should now be able find the Live DB materials listed in the Browser.

To update the browser after downloading new shaders, either restart Carrara or select Update Folder in the File/Folder menu.

®otoy
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INSTANCING

@otoy

In Carrara there are Master Objects and Instances of those master objects. In the octane plugin all instances of master objects are treated as individual meshes and not as Octane instances. Octane instances are

only created when you use a Replicator or Surface Replicator. Please see the Trees section when using trees with Replicators.

NOTE: A future update is planned where Carrara instances can be treated as Octane instances
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» GPU Settings used with a replication surface this can lead to out of memory conditions. Octane is limited in the way it handles nested instances. Instead of true nesting it flattens out all nested instances into one expanded collection.
So a tree with 10,000 leaves replicated 10,000 times will result in a scatter array of 100,000,000 instances. Since each instance takes 48 bytes of memory that would be 4.8 GB of memory needed to replicate the one
= Using the Integrated Carrara Plugin tice

= QOctaneRender Viewport (ORVP)
= Render Settings

To help manage the scattering of trees the plugin allows you to collapse the leaves and the tree into a single mesh. This usually allows you to fit the tree and the instance array into memory. However, be warned,
" Image Size flattening a tree can also result in out of memory conditions depending on the number and complexity of the leaves. In general, when you want to replicate a tree, keep it simple. Create single non-flattened trees for
& Ca::raL close up shots and simplified flattened trees for replication in the background.
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OPTIMIZING MESH
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Primitive objects in Carrara are not always as solid as they look. The mesh retumed to Octane for a cube, for instance, is actually made up of six separate surfaces instead of a solid cube. In most situations this make

little difference to the render. However, for rounded edges this makes all the difference in the world. Rounded edges only works when the edges are shared between surfaces.

To resolve this issue the plugin allows you to optimize the mesh of an object by sharing all vertices that are in the same location. By default all primitive objects are optimized, all other mesh objects are not.

Mesh optimization may not be appropriate in all cases. Sometimes you want hard edges and sometimes you don't. It is recommended that you only optimize mesh where you want to use edge rounding and the

rounding is not working.

To enable mesh optimization on an object, select the object in the Assembly Room, select the Effects tab, and locate the Octane Object section. From there you can enable or disable mesh optimization

Object : Primi

Motion

hading

NOTE: Optimizing very large meshes can significantly affect the load time of the mesh into Octane. This may be of particular concern when animating the mesh in question
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OBJECT LAYER

The Octane Object Layer is not yet implemented. This feature will be enabled in a future update.

Pri

Motion
Madifie Shading
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ANIMATION

Click on the Image

The power of Carrara is in its ability to create animations. The OctaneRender for Carrara plugin can tap into this power to create an image sequence from the Carrara timeline.

Once you have constructed an animation using the Carrara timeline you can render the image sequence by selecting the Animation tab of the OctaneRender for Carrara Settings window.

ClusssiSimontvidsasiBurest || |
n
| Render |

Frame: Select the frame where you want to start the rendering.

Starting Sequence # Here you can set the sequence number of frame zero. The Current Sequence # will be calculated from here.

Filename Prefix: Here you can set the prefix that will be used as the start of the filename for each image in the sequence.

OQutput Directory: The path to the directory that will contain the generated image sequence. Note that any existing images will be overwritten without prompting if their filenames match.
Camera Motion Blur: if enabled the camera movement will be pre-calculated to produce the camera motion blur effect

Render Single Frame: Allows a single frame to be rendered. This is useful to capture a single frame with motion blur enabled.

®otoy

Save Image: When enabled the image is saved in the image sequence. When disabled the image must be saved manually using the Octane Render View Port. This option can only be disabled when rendering a

single frame.

Render: Starts / Stops the rendering of the animation sequence (or single frame).

Images in an animation sequence are rendered until the max samples defined in the Render Target -> Kernel settings are reached.
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